APPLICATION NOTE
SSCP

Single Strand Conformation Polymorphism (SSCP)
Analysis on Applied Biosystems® 3130 and 3130xl
Capillary Electrophoresis Systems
Introduction

Increasingly in the genomics field,
researchers are requiring screening
and sequence variation detection
One widely used technique is single
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convenient, and cost-effective solution for
performing SSCP. This application note
describes the use of CAP on the Applied
Biosystems® 3130 and 3130xl Genetic
Analyzers to perform mutation screening
with SSCP.
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Figure 1. Schematic Overview of the SSCP Technique.

Overview of SSCP
SSCP analysis detects sequence variations
(single-point mutations and other smallscale changes) through electrophoretic
mobility differences. These variations
can potentially cause conformational
changes in the DNA molecules. Under
nondenaturing conditions and often
reduced temperature, single-stranded DNA
molecules can assume unique conformations
that vary depending on their nucleotide
sequences. These conformational changes
can result in detectable differences in
mobility as illustrated in Figure 1. In this
application note we will review SSCP
analysis, a technique that is widely used
for sequence variation detection because
of its simplicity and ease of use.

Experimental Protocol
SSCP Requirements
• POP™ Conformational Analysis Polymer
(CAP): A nondenaturing polymer (supplied
at a 9% concentration), which can be diluted
to a concentration of 3.0–8.1% without
glycerol or 3.0–7.2% with 10% glycerol.
• GeneScan™ 600 LIZ® Size Standard:
The fluorophore-labeled fragments are
visualized on an Applied Biosystems®
3130 or 3130xl Genetic Analyzer. The
GeneScan™ 600 LIZ® Size Standard is
used in all samples as an internal tool to
align data from different capillaries and to
minimize capillary-to-capillary or run-torun variability.

• ABI Prism® primers (oligonucleotides
labeled with 5’ fluorescence): Two different
labels (like 6FAM™ and VIC® dyes) can be
used for the forward and reverse strand to
make them more informative.

• Data collection v3.1 software contains a
“ConformationAnalysis36_CAP” module
that allows the SSCP application to run
successfully on an Applied Biosystems®
3130 or 3130xl Genetic Analyzer.

• GeneMapper® Software v4.1 for semiautomated data analysis.

Setting up the Instrument and
Preparing the Samples
See Appendices I and II for
step-by-step protocols.

• When concurrently using any Applied
Biosystems® POP™ polymers for
denaturing applications, the use of
a dedicated 36 cm capillary array is
recommended to minimize negative
performance issues as a result of residual
POP™ or CAP polymers within the array.

Collecting and Processing the Data
Data collected during electrophoresis are
analyzed with GeneMapper® Software
v4.1. Migration of sample peaks is
calculated and normalized relative to
the internal size standard. Samples can
then be aligned and compared. Results

can be validated by sequencing the
region of interest and comparing sample
sequences using Variant Reporter®
Software v1.1 (see Appendix III).
Data Normalization Using Internal Size
Standards
In order to detect small changes in mobility
between different samples, an internal
size standard should always be used
to align data from different capillaries
and to minimize capillary-to-capillary
variability. In the example shown in Figure
2, the standard deviation in sizing for
the five main peaks of sample GM06160
injected into all 16 capillaries during
one run varies between 0.03–0.09.

Figure 2. Data Aligned With the GeneScan™ 600 LIZ® Size Standard in the Sample Plot View of GeneMapper ® Software v4.1. Data from one 16-capillary array
injection. The orange trace represents the GeneScan™ 600 LIZ® Size Standard. Note that several peaks appear as split peaks reflecting different isoforms observed
under SSCP conditions; the appearance and spacing may vary with different analysis temperatures. The insert shows the main peaks of the heterozygous sample
GM06160, labeled with 6FAM™ and VIC® dyes.
Note: the sizes of the sample peaks are relatively small. In such cases the collection time can be shortened, thereby increasing the throughput. Please note that the
size standard definition will need to be adjusted accordingly to only include the size standard peaks that will be collected in this time frame.
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Figure 3. The Effect of Temperature on the Resolution of SSCP Fragments. Three DNA samples that are either homozygous for the wild type (GM13591, top), homozygous
for the mutation C282Y (GM14631, bottom), or heterozygous (GM06160, middle) for codon position 282 of the HFE gene [2] were analyzed at 25°C, 30°C, and 35°C (samples
were obtained through the Coriell Institute for Medical Research, Camden, NJ, USA). The forward strand was labeled with 6FAM™ dye (blue peaks), the reverse strand
with VIC® dye (green peaks). GeneScan™ 600 LIZ® Size Standard peaks are shown in orange. Polymer conditions used were 5% CAP and 10% glycerol in 1X TBE.

Impact of Electrophoresis Temperature
For successful identification of mutations
by SSCP, it may be necessary to optimize
electrophoretic run conditions. The most
critical condition for successful variant
detection is the run temperature. Figure 3
shows an example of how the two strands
of a PCR product (for detecting changes in
codon position 282 of the HFE gene [2]) react
to changes in electrophoresis temperature.
It is evident that the two strands labeled with
two different fluorophores have different
reactions to changes in temperature. While
at 25°C the VIC® dye–labeled (green) strands
of the heterozygous sample GM06160 are
well separated (middle) and allow for easy
identification of either a homozygous wild
type sample (top) or homozygous mutant
sample (bottom), at 35°C both main peaks
of the heterozygous sample merge, and
cannot be distinguished with certainty.
However, a comparison of the 6FAM™ dye–
labeled (blue) strands of the heterozygous
sample demonstrate a significant separation
at 35°C, but hardly any separation at
25°C. At 30°C both the VIC®- and 6FAM™
dye–labeled strands of the heterozygous
sample are sufficiently separated and allow
the identification of either a homozygous
wild type or mutant sample. Note that a
user might notice additional peaks for a
homozygous sample for either the forward
or reverse strands (in the example, the
strands labeled with 6FAM™ dye). These
additional peaks represent multiple fragment
conformations (isoforms) and can, together
with mobility shifts, be used to increase
the information content of this assay.

Assay Validation
Following the SSCP screening assay,
sequencing should be used to verify that
the mobility variation observed is indicative
of a sequence variant in the region of
interest. The sequences generated can
be analyzed with Variant Reporter®
Software v1.1. Figure 4 shows sequencing
results for the two DNA samples used
in this study that are either homozygous
or heterozygous for the G mutation, and
confirms the expected nucleotide changes.

Conclusion
This application note demonstrates the use
of POP™ Conformational Analysis Polymer
and GeneScan™ 600 LIZ® Size Standard
for variant detection in PCR amplicons by
SSCP on the Applied Biosystems® 3130 and
3130xl Genetic Analyzers. The use of the
size standard helps to minimize capillaryto-capillary and run-to-run sizing variability.
The application of different electrophoresis
temperatures can maximize the success
rate of sequence variation detection.

Figure 4. Confirmation of Base Mutations During Assay Validation Using Variant Reporter ® Software v1.1.
Consensus sequences are generated from the forward and reverse sequences of samples. Alignment of the
consensus to a reference sequence confirms the correlation between the mobility shift and a single base
change in the sequence.

Appendix I: Preparing the 3130 or 3130xl
Genetic Analyzer for SSCP Runs
Please complete the following steps for SSCP
analysis on the 3130 or 3130xl Genetic Analyzer:
1. Prepare the polymer, e.g., the
formulation for 5 g of polymer (5% CAP,
10% glycerol, 1X TBE) would be:

Note: Mix for ~3 hr at room temperature.
Before use, filter through a 0.45 μm filter.
It might be necessary to quick-spin the
filtered solution to remove air bubbles.
The prepared polymer solution is stable
at 4°C for at least two weeks. Once on
the instrument, the polymer should be
replaced after 50 injections, or one week,
whichever comes first.

• 9% Conformational Analysis Polymer: 2.78 g
• 10X TBE* (running buffer): 0.5 g

2. Prepare the run buffer, e.g., the
formulation for 50 g of buffer (10%
glycerol, 1X TBE) would be:

• 100% molecular biology grade glycerol: 0.5 g

4°C for at least two weeks. Once on the
instrument, the buffer should be replaced
after 50 injections, or one week, whichever
comes first.
3. Install a 4- or 16-capillary array. To
minimize negative performance issues as
a result of residual POP™ or CAP polymers
within an array, it is strongly recommended
that a dedicated array is used for the SSCP
application. Use the “Install Array and
Change Polymer Wizard” available in Data
Collection v3.1 to change the array and
switch to CAP polymer.

• 10X TBE: 5g
• Molecular biology grade H2O:
bring up to 5 g
* TBE in combination with glycerol is
recommended as a running buffer for this
particular application [3].

• 100% molecular biology grade glycerol: 5 g
• Molecular biology grade H2O:		
bring up to 50 g
Note: Mix for ~3 hr at room temperature.
The prepared buffer solution is stable at

Note: We recommend using 36 cm arrays.
We have not observed any significant
benefits from using a longer array.
4. Create a new run module, such as “SSCP_
CAP_x”, where x is the oven temperature.
Use the default “ConformationAnalysis36_

Figure 5. Selecting the Column Settings in the Samples Tab.

Figure 7. Configuring the Settings in the Allele Tab.

Figure 6. Selecting the Column Settings in the Genotypes Tab.

Figure 8. Configuring the Settings in the Peak
Detector Tab.

CAP” module as the template. This run
module is available in Data Collection
v3.1. Selecting run temperatures between
25°C and 35°C is recommended, as
temperatures outside of this range might
result in inconsistent run data. The default
collection time will collect all fragments
of the GeneScan™ 600 LIZ® Size Standard
at 30°C. Depending on the temperature
setting selected or the size of the amplicon
of interest, the collection time may need
to be increased or decreased. The default
settings for a 5% CAP, 10% glycerol, and
1X TBE formulation at a 30°C run are:

Note: When using TBE as the run buffer,
run voltages above 9.5 kV may have a
detrimental effect on performance.
5. Create instrument protocols for
the spectral and regular run types.
Use the G5 set with GeneScan™
600 LIZ® Size Standard.

• Run time: 3,840 sec
• Run voltage: 9.5 kV

• GeneScan™ 600 LIZ® Size Standard—
1 μL (Due to potential splitting of peaks,
a higher volume of size standard is
recommended.)
• Hi-Di™ Formamide—10 μL

6. Prepare and run a spectral standard plate,
using the “Spect36_CAP” module available
in Data Collection v3.1. Use the Matrix
Standard Set DS-33 if using GeneScan™
600 LIZ® Size Standard and 6FAM™ and
VIC® dyes as labels for the amplicons.

• Injection voltage: 5.0 kV
• Injection time: 12 sec

individual strands of the amplicons are
within the intensity range of the system.

Appendix II: Preparing the Samples
• Sample—1 μL
Note: Test different dilutions for any
given sample in order to optimize signal
intensity. Ensure that the signals for the

• Add sample, size standard, and Hi-Di™
formamide into each well of the sample
plate.
• Denature the double-stranded PCR
product for 3 min at 95°C.
• Cool on ice for 2 min to avoid re-annealing
of the complementary strands.
Run the sample plate using the
newly created run module, and then
analyze the results with GeneMapper®
Software v4.1 (see Appendix III).
Appendix III: GeneMapper® Software
Analysis
The following are guidelines for setting up
SSCP analysis in GeneMapper® Software
v4.1. The alignment of sample peaks
for comparison is facilitated by using
the GeneScan™ 600 LIZ® Size Standard.
Other settings, such as peak detection
thresholds, polynomial degree, peak
window size, or size calling method can
be customized to meet user/application
requirements. The following settings and
workflow can be used as a starting point.

Figure 9. Configuring the Settings in the Peak
Quality Tab.

Figure 10. Configuring the Settings in the Quality
Flags Tab.

Setting up the Software
Open GeneMapper® software.
1. Click File>New Project to create a
new project. In the New Project dialog
box, select AFLP, and click OK.
2. Click File>Add Samples to Project.
3. In the Add Samples to Project dialog
box, select the Files tab.
4. Navigate to the data folder and import
the sample files.

Figure 11. Applying the SSCP-Specific Parameters to the Sample Files in the Project.

5. Open the GeneMapper® Manager
(Tools>GeneMapper Manager).

6. Select the Table Settings tab and select
“New” to create a new table setting.
7. In the Table Setting Editor, select
the General tab and type “SSCP_
Table” in the Name field.
8. In the Table Setting Editor, select the
Samples tab and check the Column
Settings indicated in Figure 5.
Figure 12. Example of Size Standard Peaks in Alignment.

9. In the Table Setting Editor, select the
Genotypes tab and check the Column
Settings indicated in Figure 6.
10. Click OK to save the new table setting.
11. In the GeneMapper® Manager,
select the Analysis Method tab.
12. Click “New” to create a new
AFLP analysis method.

Figure 13. Example of Non-Aligned Size Standard Peaks.

13. In the Analysis Method Editor, select
the General tab and type “SSCP
Analysis” in the Name field.
14. Select the Allele tab and configure
the settings as shown in Figure 7.
15. Select the Peak Detector tab
and configure the settings
as shown in Figure 8.
16. Select the Peak Quality tab and configure
the settings as shown in Figure 9.

Figure 14. Example of Small Size Standard Peaks Being Hidden by Off-Scale Primer Peak Regions.

17. Select the Quality Flags tab and configure
the settings as shown in Figure 10.
18. Click OK to save the analysis method.
19. In the GeneMapper® Manager,
select the Size Standards tab.
20. Click “New” and select Basic
or Advanced in the Dye and
Analysis Method dialog box.
21. Click OK to open the Size Standard Editor.
22. In the Size Standard Editor, type
“GS600LIZ_SSCP” in the Name field
and choose “Orange” in the Size
Standard Dye pull-down menu.

23. In the “Size Standard Table” section,
add the following values to the “Size
in Basepairs” column: 20, 40, 60, 80,
100, 114, 120, 140, 160, 180, 200, 214,
220, 240, 250, 260, 280, 300, 314, 320,
340, 360, 380, 400, 414, 420, 440, 460,
480, 500, 514, 520, 540, 560, 580, 600.
24. Click OK to save the size
standard definition.
25. Apply the SSCP-specific parameters
just created to the sample files in
the project, as shown in Figure 11.

3. After the size standard peak alignment is
satisfactory, fragments of interest can be
compared to identify mobility shifts.
Note: Refer to the instrument User Guide
or contact the local Applied Biosystems
Support group for additional information.
Note: Because laboratories have
optimized procedures and protocols to suit
individual needs, be aware that separation
temperature or polymer formulation may
change. Researchers are encouraged to
optimize these procedures and protocols
to meet these specific study requirements.

26. Analyze samples.
Reviewing the Results
1. Review the Size Standard:
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